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Repeater Usage 

Overview 
This is an analogue and D-Star (sound card, GMSK modem, DVAP, DV-RPTR modem, Dummy, and 

Split) repeater control unit that runs under Windows and Linux. The analogue repeater includes 

most of the features expected of a repeater logic unit, while the D-Star repeater mimics an Icom D-

Star repeater. The analogue repeater is customisable to behave in a number of different ways, and 

to mimic existing repeater logic units. Further provision is made with the analogue controller to 

include an external input from a program such as EchoLink or IRLP, or even the Dummy Repeater. 

In addition there is the DExtra Gateway, DCS Gateway, and Parrot Controller which are meant to 

operate with the repeaters to provide further facilities. The DExtra Gateway allows access to the 

DExtra reflectors and gateways, the DCS Gateway is similar to the DExtra Gateway but accesses the 

DCS reflectors instead, and the Parrot Controller can generate audio beacons or echo incoming 

transmissions after a selectable delay. 

Hardware 
If you are using the sound card based repeaters you will need, as well as a PC, you'll also need a 

Velleman K8055 USB control board, or a URI USB combined audio card and ports, or a serial port, 

which handles all of the interfacing to the outside world, apart from the audio (except the URI USB). 

A serial port, real or virtual may also be used by the software to interface the analogue repeater to 

external programs or hardware. For the GMSK Repeater you will need a Satoshi compatible GMSK 

modem, for the DVAP Node you will need a DVAP, and for the DV-RPTR Repeater you will need a DV-

RPTR modem. 

For the Analogue Repeater the following are used: 

Function Velleman URI USB Serial Port 
(Config 1) 

Serial Port 
(Config 2) 

Serial Port 
(Config 3) 

RF Squelch 1/ 
External CTCSS Input 

Input 1 8 DSR CD CD 

RF Squelch 2 Input 2 7 CTS CD  

External Squelch Input 3     

Battery Operation Input 4 6    

Disable Input 5 5    

      

RF Transmit Output 1 1 DTR RTS RTS 

External Transmit Output 2     

Heartbeat Output 3 2 RTS DTR DTR 

Active Output 4 3    

Output 1 Output 5 4    

Output 2 Output 6     

Output 3 Output 7     

Output 4 Output 8     
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RF Squelch 1 and RF Squelch 2 are connected to a squelch output of the receiver, and are used to 

allow different squelch settings to be used for different access techniques. RF Squelch 1 is typically 

set to a lower threshold than RF Squelch 2 and represents the squelch used when receiving an input 

signal with the correct CTCSS frequency, RF Squelch 2 is used when accessing the repeater with 

carrier only and when starting the repeater up with a 1750 Hz tone and no CTCSS. In the absence of 

two squelch outputs, both should be connected together and switched as one. The software does its 

own audio muting so the radio does not need to control the audio itself unless it does already. 

The External CTCSS Input is connected to an external hardware CTCSS decoder as provided on some 

receivers. The choice to use this, or the internal decoder along with RF Squelch 1 is determined by a 

setting within the GUI.  

The External Squelch is used with external programs such as EchoLink or IRLP and is switched to 

indicate that audio is being received from this second source. 

Unlike the RF Squelch, there is only one, and it is not expected that the input audio from the external 

source will have either CTCSS or a toneburst attached. 

This input is also available from an optional serial port pin. It is probable that both programs will be 

running on the same PC and the serial port in question will be a virtual null modem cable rather than 

real hardware. 

An optional Battery Operation is provided so that the repeater can indicate to users that it is using 

batteries and therefore should be used sparingly. This is indicated by a change of the Ack as well as 

an entry on the status screen of the GUI. 

The Disable input is used to set the repeaters in to Shutdown mode, and when released will restore 

it into Listening mode. This input can be used as either an external hardware shutdown facility. A 

more interesting use is to connect this input to an Active output of another repeater to allow for two 

repeaters (e.g. analogue and D-Star) to operate side by side. This would require two sets of audio 

cards and controller boards, as well as audio splitters/combiners. 

The outputs include two which represent the internal status of the software and two for controlling 

"transmitters", real or virtual. 

The two status outputs are Heartbeat and Active, Heartbeat toggles every one second when the 

software is running correctly and is an indication of the health of the software. A lack of toggling of 

this line indicates that the software has hung and is in need of restarting. 

Active goes high when the repeater transmits and for a period afterwards, this period being set 

within the configuration programs. In the analogue repeater this line does not have the delay when 

only sending the beacon. 

RF Transmit is to key the repeater transmitter, and is allied to the Squelch1 and Squelch2 input lines. 

External Transmitter is indicative that audio for transmission over the external system (EchoLink or 

IRLP for example), this output is also optionally available on the same serial port that as the External 

Squelch input. 
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The four remaining outputs, if supported, can be used to control external hardware, and are 

accessed from the GUI menu. 

For the audio D-Star Repeater the following are used: 

Function Velleman URI USB Serial Port 
(Config 1) 

Serial Port 
(Config 2) 

Serial Port 
(Config 3) 

Transmit Output 1 1 DTR RTS RTS 

Heartbeat Output 3 2 RTS DTR DTR 

Active Output 4 3    

Output 1 Output 5 4    

Output 2 Output 6     

Output 3 Output 7     

Output 4 Output 8     

 

The meanings of the pins are identical to those used on the analogue repeater apart from only 

having one transmit output and no external battery input. See the definitions above for more 

information about the pins that are used. The GMSK Repeater and DV-RPTR Repeater also have the 

option to use a Velleman K8055 as an external controller in order to interface to an analogue 

repeater controller to form a dual-mode repeater, and to offer control options for hardware. 

Software 
If you run the pre-built Windows .exe version of the software then it is probable that you'll need to 

install a copy of the latest Visual C++ run-time libraries from Microsoft. To do this you need to 

download and run the Vcredist_x86.exe file which is found at 

http://www.microsoft.com/downloads/details.aspx?FamilyID=9b2da534-3e03-4391-8a4d-

074b9f2bc1bf&displaylang=en. This only needs to be done the once. 

The D-Star Repeaters 
There is a lot of commonality between the different D-Star repeater implementations, with the main 

differences between them relating to the way that they interface to the radio. The D-Star Repeater 

uses a sound card, the DV-RPTR Repeater uses the DV-RPTR modem, the DVAP Node uses the DVAP, 

the GMSK Repeater uses a GMSK modem, and the Dummy Repeater uses the DV-Dongle but no 

radio interfacing hardware. The Split Repeater is also an oddity as it used to split the D-Star data 

between more than one transmitter and receiver, which can be used for a non co-sited transmitter 

and receiver for example with a 6m or 10m repeater, or to have multiple receivers and then the 

software will choose the receiver receiving the best signal. 

In order to reduce the length of the document, the areas of commonality between these repeaters is 

presented here, and the repeater specific parts of the different D-Star repeaters is presented in the 

repeater specific sections below. 

An area of commonality is the configuration, and the common configuration tabs are presented 

below. 

http://www.microsoft.com/downloads/details.aspx?FamilyID=9b2da534-3e03-4391-8a4d-074b9f2bc1bf&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=9b2da534-3e03-4391-8a4d-074b9f2bc1bf&displaylang=en
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The Callsign Tab 

 

Here you enter your chosen radio Callsign without the usual D-Star suffix. The suffix is one of A, B, or 

C with C for 2m, B for 70cms, and A for 23cms. Other bands like 6m, 4m, 220MHz, or 928MHz are 

more problematic. The program will append the two parts with the correct number of spaces. The 

Gateway callsign is also set here, typically it will be the same as the main callsign, but need not be, 

the G at the end of the callsign is appended automatically. 

The Mode allows for the selection of “Simplex”, “Duplex”, “Gateway”, “RX Only”, “TX Only”, or “TX 

and RX”, with the default being Duplex. In Duplex mode the repeaters acts just like an Icom D-Star 

repeater and requires the use of seperate transmitters and receivers, as well as cavity filters, etc. In 

Simplex mode only one transceiver is required, and any valid input signal is transferred over to the 

network without being transmitted, and any input from the network is transmitted, no acks are 

generated in this mode. This allows for a simple D-Star point of presence to be established. 

The Gateway mode allows the software to be used as a remote access to the D-Star network (with 

appropriate gateway software) to a standalone D-Star repeater. This mode uses either a simplex or 

duplex radio and appears as a normal user to the standalone repeater with network access. The 

callsigns being sent through the standalone repeater will appear a little different to using a fully 

connected D-Star repeater, but it will be very similar to use. 

The remaining three modes are for use with the Split Repeater. In “RX Only” mode, the repeater only 

passes received data and will never transmit, conversely the “TX Only” mode is the opposite with the 

repeater only transmitting data and not receiving. The “TX and RX” mode is a combination of the “TX 

Only” and “RX Only” mode with the transmit and receive processing operating completely 

independently and the Split Repeater doing the main processing. 
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Note that this Mode setting is more restricted on the DVAP Node because it is a simplex only device 

and only runs 10mW on transmit, therefore neither the “Duplex”, “Gateway”, nor the “TX and RX” 

modes are available for that hardware. 

The Ack setting is to make the repeater software send a short transmission after each transmission, 

this can be thought of as an acknowledgement. This is switchable via the Ack option. Typically this 

will be enabled in Simplex or Duplex mode, this makes no sense in Gateway mode and is disabled, 

and set to Disabled when the mode is set to anything other than Simplex or Duplex. The options are 

“Off”, “BER”, or “Status”, with Off disabling the ack altogether, BER setting the ack text to include 

the callsign of any linked systems and the bit error rate (BER) of the last transmission, and Status sets 

the ack test to be the full link status text in the appropriate language. 

Restrict is used to limit the stations allowed to access the repeater to those whose first seven 

character of their callsign (my) is the same as the repeater. This restriction was added to allow for 

the creation of hot spots with limited third-party access, as required by the UK licence unless 

specially licenced. For example with Restrict set to Yes, and my repeater callsign was "G4KLX  C", I 

would be able to access with my callsign set to "G4KLX  x" where x may be any character. 

Attempts to access a restricted repeater are logged. 

RPT1 Validation which is by default on, is used control access to the repeater based on RPT1. If it is 

on then only stations in duplex mode with the correct callsign set in the RPT1 position, this is 

standard behaviour for D-Star repeaters. If it is set to off then a D-Star radio in simplex mode can 

also access the repeater and the correct values will be inserted into RPT1 and RPT2 within the 

repeater software. 

The Network Tab 
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The Network tab is for entry of the IP address, not hostname, of the Gateway to the D-Star Reflector. 

This should be in standard dotted IP notation. Leaving the IP address as blank stops the Repeater 

from communicating with a Gateway. The port of the Gateway is set here and should be between 1 

and 65535 with the default being 20010. 

An entry for the Local Address is also available so that the repeater can be bound to a specific 

interface, real or virtual. Like the gateway address, this is in dotted IP address notation and not a 

hostname. Setting this entry to blank allows the repeater to bind to all network ports, the default. 

The local port can also be set, with the value being between 1 and 65535 and the default being 

20011. It is not recommended that port numbers of 20001, 30001, 30051, or 40000 are used for 

either the Gateway or Local Port. 

The values in this tab should match the values on the Gateway and Repeater tabs within the ircDDB 

Gateway and on the Repeater tab of the DExtra or DCS Gateway and the Network Tab of the Parrot 

Controller. 

The Timers Tab 

 

This controls the repeater timers, the timeout, and the period of time between a transmission 

ending and the ack being transmitted. The defaults for these are 180s and 500ms respectively, 

setting the timeout to zero removes the timeout. Changes to the configuration only take effect once 

the software has been restarted. Note that the timeout only affects radio users and not ones coming 

in from the network, it is expected that the remote systems will provide the required timeout. 

The ack timer has a different use when in Gateway mode (see above), in that mode it is the time 

after the last transmission coming in via the network before the next transmission coming in via the 

network will be handled. This is to ensure that the repeater has time to send its ack, before the next 

one is transmitted. 
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The Timers Tab for the D-Star Repeater has one more entry than the Timers Tab in the other 

software and is covered in its own section below. 

The Beacon Tab 

 

The beacon timer is used by the repeater to control the transmission of a repeater identification 

transmission when the repeater is not in use. The beacon may be silent with slow data text 

associated with it, or it may include audio which spells the callsign of the repeater as well as the slow 

data text. 

The default beacon time is ten minutes, and setting it to zero suppresses the beacon. The text 

transmitted is set here, and by default is the name of the repeater software along with the version 

date, it is recommended that this text be replaced with something more meaningful, up to a 

maximum of twenty characters. 

Setting the Voice entry to On enables the beacon audio, and it is important that the language is also 

set correctly in this case so that the sound of the beacon is correct. 
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The Control 1 and Control 2 Tabs 

 

 

These are to allow remote control of the D-Star repeater using values of Your, RPT1 and RPT2 

callsigns. The use of these commands is enabled or disabled at the top, and if enabled then values 

should be entered into the four fields. They do not need to be valid callsigns, and they will not be 

relayed through the repeater. The correct combination of RPT1, RPT2 and the Shutdown value in 

Your callsign will shutdown the repeater, while the correct combination of RPT1, RPT2 and the 

Startup value will restart it if it is shutdown. 
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The control entries for Status 1, Status 2, Status 3, Status 4, and Status 5 are used for triggering the 

status messages from the repeater. These messages are passed to the repeater from the ircDDB 

Gateway and are displayed on the screen, and the correct combination of Your, Rpt1, and Rpt2 will 

trigger a reply from the repeater with the status message in the slow data portion of the 

transmission. 

The Output 1 to Output 4 commands flip the state of four output lines, if they are available. 

Up to two external commands may be setup to run based on combinations of Your, RPT1, RPT2 

callsigns. On the screen there are two entries each for Command 1 and Command 2, the first entry is 

the Your callsign used to invoke them, the second entry is the command itself. This text is sent to the 

shell and is outside the control of the repeater software, so be careful! 

Note that configuration changes do not take effect until the software is re-started. 

All commands are logged along with the My callsign, even for failed commands that have the correct 

RPT1 and RPT2 but not the correct values of Your callsign. It should be noted that the value used for 

RPT1 used here must be different from the callsign used for the repeater otherwise it will not 

correctly relay users. 

The Controller Tab 

 

With the GMSK and DV-RPTR Repeaters, an optional controller may be specified so that the repeater 

may be interfaced to an analogue repeater controller, or to allow for the use of the controller to 

control local hardware. 

The Type may only be a Velleman K8055, with the choice of up to one of four hardware addresses 

which are set on the Velleman PCB. The Time entry sets the hang time to be used on the active line. 
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This will remain high for the pre-defined period after the repeater has stopped processing an 

incoming D-Star transmission, this includes timeouts and inputs with an invalid RPT1 setting. 

The main screen simply shows the status of the repeater, and there are no controls to operate. You'll 

see a summary of any received stations, and a simple status panel to show what the repeater is 

doing. 

Normally the GUI is disabled but it may be switched on in the Release build by specifying the -gui 

option on the command line, or by clicking on the View menu and enabling the GUI Updates. 

The Status section shows the internal status of the repeater. The RX State shows the status of the 

receiver state machine, while the Rpt State shows the overall repeater state and it has a number of 

values including Listening, Waiting, Timeout, Valid and Invalid. An incoming D-Star transmission may 

not have the correct value in RPT1 or some other setting, and such a transmission would be received 

correctly but counted as Invalid and not relayed. 

The TX value mirrors the transmit output pin on the modem. 

The Headers section shows information about the currently received D-Star transmission, the 

callsigns in the header, and the header flags (in hex). This header is shown only if the header isn't 

corrupt but is shown even if it isn't valid from the point of view of the repeater. 

The Timers section shows the state of the internal timers, all of their meanings have been discussed 

above, except for the watchdog. The values are displayed as n1/n2 where n1 is the current counting 

value and n2 is the trigger value, the values of n1 may go over n2 in operation. A value of zero for n1 

indicates that the time is not active as will be seen. 

It is possible to write .dvtool files of all the local RF D-Star traffic by enabling the Logging option on 

the File menu. This creates a .dvtool file for each incoming RF transmission, and can quickly fill up a 

disk unless care is taken to remove old .dvtool files. 

The D-Star Repeater 
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DStarRepeater.exe [-nolog] [-gui] [-logdir directory] [-confdir directory] [config name] 

dstarrepeater [-nolog] [-gui] [-logdir directory] [-confdir directory] [config name] 

dstarrepeaterd [-daemon] [-nolog] [-logdir directory] [-confdir directory] [config name] 

 

On Windows the D-Star Repeater program is named DStarRepeater.exe and is a GUI based program, 

as is the Linux version which is named dstarrepeater. Also on Linux is a program named 

dstarrepeaterd which is a command line version of the repeater. 

The -daemon command line switch is used on the command line version to put the program into the 

background, and to disassociate it from the controlling terminal. The program will return 

immediately, but using the ps command will show that it is running in the background. 

All versions have an optional parameter which signifies the configuration to be used, and this must 

be set on the command line when running as well as configuring the repeater. This name will appear 

on the title bar as well as affecting the name of the log file used. The location of the configuration 

file, which is used when running under Linux is normally found in the /etc directory. The -confdir 

option allows the location of the users’ home directory to be set explicitly, the –confdir option is also 

valid under Windows but performs no function. 

The program is configured by choosing the Preferences option under the Edit menu entry at the top 

of the screen. 

Many of the settings are covered in the generic D-Star Repeater section above, so only the D-Star 

Repeater specific parts are detailed below. 
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The Timers Tab 

 

This tab controls the repeater timers, the timeout, the period of time between a transmission ending 

and the ack being transmitted, and the transmitter hang timer. The defaults for these are 180s, and 

500ms respectively, setting the timeout to zero removes the timeout. Changes to the configuration 

only take effect once the software has been restarted. Note that the timeout only affects radio users 

and not ones coming in from the network, it is expected that the remote systems will provide the 

required timeout. 

The ack timer has a different use when in Gateway mode (see above), in that mode it is the time 

after the last transmission coming in via the network before the next transmission coming in via the 

network will be handled. This is to ensure that the repeater has time to send its ack, before the next 

one is transmitted. 

The hang timer is used to control the length of time from the end of the GMSK transmission and the 

transmitter being switched off. A setting of zero means that the transmitter switches off 

immediately after the GMSK ends, a low value may be used in cases where the transmitter switches 

off too quickly, a much larger value can be used to bridge the gap between the transmission and the 

transmitted ack. This may be useful with older transmitters or in order to reduce the 

transmit/receive change overs. 
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The Radio Tab 

 

This contains the audio ports, mode and GMSK inversion. The audio ports are the ones where the 

audio from the discriminator and the drive to the modulator is set. Testing has shown that the best 

results are obtained when using the cheapest external USB sound card that you can find! Probably 

due to the lack of filtering on them. 

The RX and TX Levels are used for equalising the levels between the Analogue and D-Star repeaters 

when they share the same transmitter and receiver, if you are not running in such a configuration 

then just set leave them at 100% and forget about it. The levels set on these sliders act immediately 

within the software to help with setting the correct levels, however any new setting is not saved 

unless the OK button is pressed. 

The Squelch Level is used to set the level of the internal noise squelch. This is used to determine 

whether there is an incoming D-Star signal by detecting the change in the noise level. It is used to 

help with detecting the end of the D-Star transmission and signal drop-outs. Changing the level on 

the slider makes an immediate change to the level used within the repeater software, however the 

value will only be saved for the next time if the OK button is pressed. 

The Squelch Mode can be set to one of Normal, Inverted, or Open. In Normal mode, which is the 

default, the noise squelch detects the presence of a D-Star signal when the noise drops. In Inverted 

mode, the noise squelch operates in the same way as a normal squelch, where the noise level rises 

when there is an incoming D-Star signal, this mode should be used when using the repeater with a 

radio that has its own built-in squelch gate. The Open mode is used to set the squelch to always 

open, which may be useful if it isn't possible to find a suitable level that allows the noise squelch to 

operate properly. 
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The GMSK inversion is set when the signal from the discriminator is inverted compared to what the 

software expects, and a separate inversion is settable for transmission when the same is true for the 

modulator. The GMSK inversion is set when the signal from the discriminator is inverted compared 

to what the software expects, and a separate inversion is settable for transmission when the same is 

true for the modulator. 

The Controller Tab 

 

This sets hardware device used to control the transmitter, take input from the receiver and also the 

watchdog output is sent. Although not very useful, this may set to None for testing. A PTT Delay can 

be set here to ensure that the transmitter operates at exactly the same time that the D-Star audio is 

present. If the delay is positive then the PTT is delayed with respect to the audio, and if it is negative 

then the audio is delayed with respect to the PTT.  

The PTT inversion setting is for interfacing to radios that have the opposite sense. 

If the serial port is selected then it is possible to select one of two different pin configurations. The 

original configuration is named "Config 1" and a new set of pins are named "Config 2" and "Config 

3". A full listing of which pins are used for which purpose is to be seen at the top of this document. In 

the context of the D-Star repeater, "Config 2" and "Config 3" are identical and have been included to 

remain consistent with the analogue repeater controller. 
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The Active Output Tab 

 

This sets the hang time to be used on the active line. This will remain high for the pre-defined period 

after the repeater has stopped processing an incoming D-Star transmission, this includes timeouts 

and inputs with an invalid RPT1 setting. 

A log of actions and errors is to be found in the file DStarRepeater-YYYY-MM-DD.log where YYYY-

MM-DD is the current date. This file is normally found in the users’ home directory under Windows 

and /var/log under Linux, but this location may be overridden by the -logdir command line option. 

The log may be disabled by giving the -nolog option on the command line. Logging is still performed, 

but it goes to stderr and therefore may easily be ignored, or redirected to another target. A copy of 

the last three lines of the log is displayed at the bottom of the GUI screen. 

The main screen simply shows the status of the repeater, and there are no controls to operate. You'll 

see a summary of any received stations, and a simple status panel to show what the repeater is 

doing. 

Normally the GUI is disabled but it may be switched on in the Release build by specifying the -gui 

option on the command line, or by clicking on the View menu and enabling the GUI Updates. 

The Status section shows the internal status of the repeater. The RX State entry has a number of 

values which include Listening, Frame Sync, Header, and Processing which is all to do with the 

reception of a D-Star transmission. The Rpt State has a number of values including Listening, 

Waiting, Timeout, Valid and Invalid. An incoming D-Star transmission may not have the correct value 

in RPT1 or some other setting, and such a transmission would be received correctly but counted as 

Invalid and not relayed. The TX value mirrors the transmit output pin on the hardware interface. 

The Receiver section shows the state of the internal noise squelch as well as the current value of the 

noise squelch output. This latter value can be used to set the squelch level in the preferences. 
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The Headers section shows information about the currently received D-Star transmission, the 

callsigns in the header and the header flags (in hex). This header is shown only if the header isn't 

corrupt but is shown even if it isn't valid from the point of view of the repeater. 

The Timers section shows the state of the internal timers, all of their meanings have been discussed 

above, except for the watchdog. The values are displayed as n1/n2 where n1 is the current counting 

value and n2 is the trigger value, the values of n1 may go over n2 in operation. A value of zero for n1 

indicates that the time is not active as will be seen. 

There is a menu entry named Actions which allows local use of the remote commands for the 

software. These are Shutdown, Startup, Command 1 and Command 2. 

There is a menu item named Outputs which allows access to the menu items that control the output 

lines. These items are labelled "Output 1", "Output 2", "Output 3" and "Output 4". These are toggles 

and they retain their state between invocations of the software. 

It is possible to write .dvtool files of all the local RF D-Star traffic by enabling the Logging option on 

the File menu. This creates a .dvtool file for each incoming RF transmission, and can quickly fill up a 

disk unless care is taken to remove old .dvtool files. 

The Open option on the File menu is used for testing, and the presence of an input file also triggers 

both squelch inputs within the software too. Any WAV file used for this input must be mono and 

sampled at 48000 Hz, otherwise it will be rejected. 
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The Dummy Repeater 

 

 

DummyRepeater.exe [-nolog] 

dummyrepeater [-nolog] 

 

In use, the entries in the UR, RPT1, and RPT2 controls are set to the same values as you would expect 

to program into a radio, the example above gives an idea of what is expected. The values set in the 

UR, RPT1, and RPT2 controls are stored by the program and are restored when the program is 

started again. 

Incoming transmissions appear in the Current area, and also in the list at the bottom of the screen. If 

any text is received from the user then that will appear also. The Repeater section shows data sent 

out from the gateway to the repeater which would appear over the air under various circumstances. 

To transmit, set the callsigns correctly, and press the Transmit button. This is a toggle button and so 

does not need to be pressed continuously whilst on air. It should be clicked again to go back to 

receive. When on transmit, a message saying “Transmit” appears with a red background on the GUI 

to remind you of your status, if hat message goes off while the transmit button has been pressed 

then that probably means that you have timed out (see later). 
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A log of actions and errors is to be found in the file DummyRepeater-YYYY-MM-DD.log where YYYY-

MM-DD is the current date. This file is found in the users’ home directory, however it can be 

disabled by passing the –nolog command line option when the program is started. 

The program is configured by choosing the Preferences option under the Edit menu entry at the top 

of the screen. 

It is possible to control the transmit and receive functions of the Dummy Repeater from external 

interfaces, these are the same ones that are supported by the Analogue Repeater, albeit simplified. 

This is controlled by the Controller tab of the preferences detailed below. 

The Callsign Tab 

 

This is where your callsign should be entered, the Callsign includes both parts of your callsign, the 

eight character main part and the four character extension. 

The Sound Card Tab 

 

This tab is where the sound card that is used for the microphone and speaker is set up. 

The DV-Dongle Tab 
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This is where the COM port where the DV-Dongle is connected is set. If in doubt as to which port is 

correct, go into the Hardware and Devices of the Windows Control Panel to find the one allocated to 

the DV-Dongle. 

The Controller Tab 

 

This is where the optional external interface can be set. The default is to have no external hardware 

control, but if set, the pin assignments are: 

Function Velleman URI USB Serial Port 
(Config 1) 

Serial Port 
(Config 2) 

Squelch Input Input 1 8 DSR CD 

Transmit Output Output 1 1 DTR RTS 

 

For various reasons, the status of the squelch input line, and hence the Transmit signal is not 

displayed in the GUI when using the external hardware interface. It should also be noted that the 

end bleep as set by the Bleep Tab below, is not needed as the drop of the transmit signal from the 

Dummy Repeater should be enough to indicate that the incoming signal has ended. Therefore it is 

recommended that the end bleep be disabled when the Dummy Repeater is used with external 

hardware. 

Currently the timeout as set in the Timeout Tab below is not active when using the external control 

hardware so it is possible for an incoming transmission to timeout an attached D-Star repeater. 

The Timeout Tab 

 

Just like a real repeater, a timeout has to be set within the Dummy Repeater, the standard for D-Star 

is 180 seconds, and after this time the repeater will revert to receive automatically. The timeout only 

affects transmissions initiated within the GUI and not those controlled by the external hardware. 
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The Message Tab 

 

Just like a standard D-Star radio, you can set the contents of the slow data text message sent over 

the air by the repeater. The limit is twenty characters, just like on an Icom D-Star radio. 

The Bleep Tab 

 

Since there is no squelch tail with D-Star, all D-Star radios include a bleep at the end of reception of a 

signal in order to indicate that it has ended, this software is no different. It is possible to switch the 

bleep off, as an indication of an incoming signal is available via the GUI, but leaving it on gives a 

more authentic D-Star experience! The frequency and length of the bleep were modelled on my 

Icom IC-91AD handheld radio. 

It is recommended that the end bleep is disabled when the Dummy Repeater is being used with 

external control hardware. 

 



 
Jonathan Naylor, G4KLX 21 28.04.2012 

The DVAP Node 

 

 

DVAPNode.exe [-nolog] [-gui] [-logdir directory] [-confdir directory] [config name] 

dvapnode [-nolog] [-gui] [-logdir directory] [-confdir directory] [config name] 

dvapnoded [-daemon] [-nolog] [-logdir directory] [-confdir directory] [config name] 

 

On Windows the DVAP Node program is named DVAPNode.exe and is a GUI based program, as is the 

Linux version which is named dvapnode. Also on Linux is a program named dvapnoded which is a 

command line version of the repeater. 

The -daemon command line switch is used on the command line version to put the program into the 

background, and to disassociate it from the controlling terminal. The program will return 

immediately, but using the ps command will show that it is running in the background. 

All versions have an optional parameter which signifies the configuration to be used, and this must 

be set on the command line when running as well as configuring the repeater. This name will appear 

on the title bar as well as affecting the name of the log file used. The location of the configuration 

file, which is used when running under Linux is normally found in the /etc directory. The -confdir 

option allows the location of the users’ home directory to be set explicitly, it is also a valid option 

under Windows but performs no function. 

The program is configured by choosing the Preferences option under the Edit menu entry at the top 

of the screen. 

Many of the settings are covered in the generic D-Star Repeater section above, so only the D-Star 

Repeater specific parts are detailed below. 



 
Jonathan Naylor, G4KLX 22 28.04.2012 

The DVAP Tab 

 

This allows for the settings on the DVAP to be set. The first entry is the Port which is the virtual serial 

port used by the DVAP. Under Windows only virtual serial ports that are associated with FTDI chips, 

as used on the DVAP will be displayed. The next entry is the Frequency, which is the transmit and 

receiver frequency in Hertz. Next is the transmit power in dBm which ranges from -12 dBm (0.06 

mW) to +10 dBm (10 mW), the default is the full +10 dBm. Next is the squelch level which may be in 

the range from -128 dBm to -45 dBm, with the default being -100 dBm. Finally the Offset may be set, 

this allows the DVAP frequency to be adjusted in the range +-2000 Hertz. 

Note that configuration changes do not take effect until the software is re-started. 

A log of actions and errors is to be found in the file DVAPNode-YYYY-MM-DD.log where YYYY-MM-

DD is the current date. This file is normally found in the users’ home directory under Windows and 

/var/log under Linux, but this location may be overridden by the -logdir command line option. The 

log may be disabled by giving the -nolog option on the command line. Logging is still performed, but 

it goes to stderr and therefore may easily be ignored, or redirected to another target. A copy of the 

last three lines of the log is displayed at the bottom of the GUI screen. 

The main screen simply shows the status of the repeater, and there are no controls to operate. You'll 

see a summary of any received stations, and a simple status panel to show what the repeater is 

doing. 

Normally the GUI is disabled but it may be switched on in the Release build by specifying the -gui 

option on the command line, or by clicking on the View menu and enabling the GUI Updates. 

The Status section shows the internal status of the repeater. The State has a number of values 

including Listening, Waiting, Timeout, Valid and Invalid. An incoming D-Star transmission may not 

have the correct value in RPT1 or some other setting, and such a transmission would be received 

correctly but counted as Invalid and not relayed. 

The TX value mirrors the transmitter on the DVAP. 

The Receiver section gives information about the receiver on the DVAP. It shows the status of the 

Squelch and the Strength of the incoming signal. The signal strength is in dBm which allows for the 

correct setting of the Squelch level in the Preferences, although the default value works reasonably 

well. 
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The Headers section shows information about the currently received D-Star transmission, the 

callsigns in the header, and the header flags (in hex). This header is shown only if the header isn't 

corrupt but is shown even if it isn't valid from the point of view of the repeater. 

The Timers section shows the state of the internal timers, all of their meanings have been discussed 

above, except for the watchdog. The values are displayed as n1/n2 where n1 is the current counting 

value and n2 is the trigger value, the values of n1 may go over n2 in operation. A value of zero for n1 

indicates that the time is not active as will be seen. 

It is possible to write .dvtool files of all the local RF D-Star traffic by enabling the Logging option on 

the File menu. This creates a .dvtool file for each incoming RF transmission, and can quickly fill up a 

disk unless care is taken to remove old .dvtool files. 

 

The DV-RPTR Repeater 

 

 

DVRPTRRepeater.exe [-nolog] [-gui] [-logdir directory] [-confdir directory] [config name] 

dvrptrrepeater [-nolog] [-gui] [-logdir directory] [-confdir directory] [config name] 

dvrptrrepeaterd [-daemon] [-nolog] [-logdir directory] [-confdir directory] [config name] 

 

On Windows the DV-RPTR Repeater program is named DVRPTRRepeater.exe and is a GUI based 

program, as is the Linux version which is named dvrptrrepeater. Also on Linux is a program named 

dvrptrrepeaterd which is a command line version of the repeater. 

The -daemon command line switch is used on the command line version to put the program into the 

background, and to disassociate it from the controlling terminal. The program will return 

immediately, but using the ps command will show that it is running in the background. 
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All versions have an optional parameter which signifies the configuration to be used, and this must 

be set on the command line when running as well as configuring the repeater. This name will appear 

on the title bar as well as affecting the name of the log file used. The location of the configuration 

file, which is used when running under Linux is normally found in the /etc directory. The -confdir 

option allows the location of the users’ home directory to be set explicitly, it is also a valid option 

under Windows but performs no function. 

The program is configured by choosing the Preferences option under the Edit menu entry at the top 

of the screen. 

Many of the settings are covered in the generic D-Star Repeater section above, so only the D-Star 

Repeater specific parts are detailed below. 

The DV-RPTR Tab 

 

This allows for the port of the DV-RPTR modem to be set. On Linux the port is similar to 

/dev/ttyACM0 and on Windows it appears as a standard serial port. The other settings are common 

to all platforms. They are whether to invert the signal in the transmit or receive paths, which port to 

use on the modem, the default is the A port. The next two are sliders and control the audio level, 

between 0 and 100%, and the transmit delay before the audio is sent, which can be set in 

milliseconds. 

A log of actions and errors is to be found in the file DVRPTRRepeater-YYYY-MM-DD.log where YYYY-

MM-DD is the current date. This file is normally found in the users’ home directory under Windows 

and /var/log under Linux, but this location may be overridden by the -logdir command line option. 

The log may be disabled by giving the -nolog option on the command line. Logging is still performed, 

but it goes to stderr and therefore may easily be ignored, or redirected to another target. A copy of 

the last three lines of the log is displayed at the bottom of the GUI screen. 
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The main screen simply shows the status of the repeater, and there are no controls to operate. You'll 

see a summary of any received stations, and a simple status panel to show what the repeater is 

doing. 

Normally the GUI is disabled but it may be switched on in the Release build by specifying the -gui 

option on the command line, or by clicking on the View menu and enabling the GUI Updates. 

The Status section shows the internal status of the repeater. The RX State shows the status of the 

receiver state machine, while the Rpt State shows the overall repeater state and it has a number of 

values including Listening, Waiting, Timeout, Valid and Invalid. An incoming D-Star transmission may 

not have the correct value in RPT1 or some other setting, and such a transmission would be received 

correctly but counted as Invalid and not relayed. 

The TX value mirrors the transmit output pin on the DV-RPTR modem. 

The Headers section shows information about the currently received D-Star transmission, the 

callsigns in the header, and the header flags (in hex). This header is shown only if the header isn't 

corrupt but is shown even if it isn't valid from the point of view of the repeater. 

The Timers section shows the state of the internal timers, all of their meanings have been discussed 

above, except for the watchdog. The values are displayed as n1/n2 where n1 is the current counting 

value and n2 is the trigger value, the values of n1 may go over n2 in operation. A value of zero for n1 

indicates that the time is not active as will be seen. 

There is a menu entry named Actions which allows local use of the remote commands for the 

software. These are Shutdown, Startup, Command 1 and Command 2. 

It is possible to write .dvtool files of all the local RF D-Star traffic by enabling the Logging option on 

the File menu. This creates a .dvtool file for each incoming RF transmission, and can quickly fill up a 

disk unless care is taken to remove old .dvtool files. 

 

The GMSK Repeater 
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GMSKRepeater.exe [-nolog] [-gui] [-logdir directory] [-confdir directory] [config name] 

gmskrepeater [-nolog] [-gui] [-logdir directory] [-confdir directory] [config name] 

gmskrepeaterd [-daemon] [-nolog] [-logdir directory] [-confdir directory] [config name] 

 

On Windows the GMSK Repeater program is named GMSKRepeater.exe and is a GUI based program, 

as is the Linux version which is named gmskrepeater. Also on Linux is a program named 

gmskrepeaterd which is a command line version of the repeater. 

The -daemon command line switch is used on the command line version to put the program into the 

background, and to disassociate it from the controlling terminal. The program will return 

immediately, but using the ps command will show that it is running in the background. 

All versions have an optional parameter which signifies the configuration to be used, and this must 

be set on the command line when running as well as configuring the repeater. This name will appear 

on the title bar as well as affecting the name of the log file used. The location of the configuration 

file, which is used when running under Linux is normally found in the /etc directory. The -confdir 

option allows the location of the users’ home directory to be set explicitly, it is also a valid option 

under Windows but performs no function. 

The program is configured by choosing the Preferences option under the Edit menu entry at the top 

of the screen. 

Many of the settings are covered in the generic D-Star Repeater section above, so only the D-Star 

Repeater specific parts are detailed below. 
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The Modem Tab 

 

This allows for the type of driver, and the address, of the GMSK modem to be set. On Windows the 

default driver type is WinUSB, with the other option being for the LibUSB driver. On Linux the only 

driver is LibUSB and no option for choosing the driver is available. The default address is 0x300 

which is also the default for the GMSK modem, however in order to have more than one GMSK 

modem attached to a PC, they need to have unique addresses. The value given here must match the 

value set in the firmware. 

A log of actions and errors is to be found in the file GMSKRepeater-YYYY-MM-DD.log where YYYY-

MM-DD is the current date. This file is normally found in the users home directory under Windows 

and /var/log under Linux, but this location may be overridden by the -logdir command line option. 

The log may be disabled by giving the -nolog option on the command line. Logging is still performed, 

but it goes to stderr and therefore may easily be ignored, or redirected to another target. A copy of 

the last three lines of the log is displayed at the bottom of the GUI screen. 

The main screen simply shows the status of the repeater, and there are no controls to operate. You'll 

see a summary of any received stations, and a simple status panel to show what the repeater is 

doing. 

Normally the GUI is disabled but it may be switched on in the Release build by specifying the -gui 

option on the command line, or by clicking on the View menu and enabling the GUI Updates. 

The Status section shows the internal status of the repeater. The State has a number of values 

including Listening, Waiting, Timeout, Valid and Invalid. An incoming D-Star transmission may not 

have the correct value in RPT1 or some other setting, and such a transmission would be received 

correctly but counted as Invalid and not relayed. 

The TX value mirrors the transmit output pin on the GMSK modem. 
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The Headers section shows information about the currently received D-Star transmission, the 

callsigns in the header, and the header flags (in hex). This header is shown only if the header isn't 

corrupt but is shown even if it isn't valid from the point of view of the repeater. 

The Timers section shows the state of the internal timers, all of their meanings have been discussed 

above, except for the watchdog. The values are displayed as n1/n2 where n1 is the current counting 

value and n2 is the trigger value, the values of n1 may go over n2 in operation. A value of zero for n1 

indicates that the time is not active as will be seen. 

There is a menu entry named Actions which allows local use of the remote commands for the 

software. These are Shutdown, Startup, Command 1 and Command 2. 

It is possible to write .dvtool files of all the local RF D-Star traffic by enabling the Logging option on 

the File menu. This creates a .dvtool file for each incoming RF transmission, and can quickly fill up a 

disk unless care is taken to remove old .dvtool files. 

 

The Analogue Repeater 

 

 

AnalogueRepeater.exe [-nolog] [-gui] [-logdir directory] [-confdir directory] [config name] 

analoguerepeater [-nolog] [-gui] [-logdir directory] [-confdir directory] [config name] 

analoguerepeaterd [-daemon] [-nolog] [-logdir directory] [-confdir directory] [config name] 

 

On Windows the Analogue Repeater program is named AnalogueRepeater.exe and is a GUI based 

program, as is the Linux version which is named analoguerepeater. Also on Linux is a program 

named analoguerepeaterd which is a command line version of the repeater. 
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The -daemon command line switch is used on the command line version to put the program into the 

background, and to disassociate it from the controlling terminal. The program will return 

immediately, but using the ps command will show that it is running in the background. 

All versions have an optional parameter which signifies the configuration to be used, and this must 

be set on the command line when running as well as configuring the repeater. This name will appear 

on the title bar as well as affecting the name of the log file used. The location of the configuration 

file, which is used when running under Linux is normally found in the /etc directory. The -confdir 

option allows the location of the users’ home directory to be set explicitly, it is also a valid option 

under Windows but performs no function. 

The program is configured by choosing the Preferences option under the Edit menu entry at the top 

of the screen. 

The Callsign Tab 

 

 

This allows for the setting of the opening, closing, and the two beacon repeater callsigns or sound 

files. which are heard at intervals when the repeater is in use. Beacon 1 is only heard when the 

repeater is in use, while Beacon 2 is transmitted periodically when the repeater is not in use. For all 

of these settings, the CW may contains all of the letters and numbers as well as /?=, and space. 

An option is to use pre-recorded WAV files instead of the internally generated CW. If using the 

internally generated CW then the choice on the left should be set to "CW Open ID", "CW Close ID", 

"CW Beacon 1" or "CW Beacon 1" as needed, and the text to be sent entered in the available text 

box, the keying speed (8-25 WPM) and the tone (500-2000 Hz) are settable. If a WAV file is to be 
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used, it must be mono and sampled at 48000 samples per second, and the choice on the left set to 

"WAV Open ID", "WAV Close ID", "WAV Beacon 1", and "WAV Beacon 2" as needed. The file name 

and full path should be entered into the available text box, pressing the "Choose..." button allows a 

file to be selected from the file system to make life easier. 

The first audio level is that used for the opening and closing/periodic and beacon when there is no 

other audio being transmitted by the repeater, while the second audio level is that used when the 

callsign is being transmitted underneath a relayed station. The audio level sliders operate in real-

time on the levels sent out by the repeater to aid setting up, however the values will only be stored 

if the OK button is pressed. 

The Acknowledgements Tab 

 

This is where information about the acknowledgment for both radio and external transmissions is 

set, these are free from text that are constrained to be valid CW characters. Typical values would be 

none, K, or E, although almost any ack is possible. To emulate a repeater which sends a series of pips 

before closedown, set the ack text to be "E    E" where the number of spaces controls the delay 

between the pips, as well as the speed setting. The Speed, Frequency and Level settings are identical 

in function to those settings for the Repeater Ids above, but there is only one level setting. The level 

slider operates in real-time on the levels sent out by the repeater to aid setting up, however the 

values will only be stored if the OK button is pressed. 

The Ack sets the amount of time between the end of a transmission and the acknowledgment is set, 

this is usually one second, but can be a value between 100ms and three seconds. The Minimum sets 

the number of seconds that a transmission must be present before an acknowledgment will be sent, 
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this can be between zero and ten seconds, where zero indicates no minimum transmission is 

needed. Probably not a good idea! 

An option is to use pre-recorded WAV files instead of the internally generated CW acks. If using the 

internally generared CW then the choice on the left should be set to "CW Radio Ack" or "CW 

External Ack" as needed, and the text to be sent entered in the available text box, the keying speed 

(8-25 WPM) and the tone (500-2000 Hz) are settable. If a WAV file is to be used, it must be mono 

and sampled at 48000 samples per second, and the choice on the left set to "WAV Radio Ack" or 

"WAV External Ack" as needed. The file name and full path should be entered into the available text 

box, pressing the "Choose..." button allows a file to be selected from the file system to make life 

easier. 

The battery ack changes is sent when the battery line is set on the input, and the ack is changed to 

inform users of being in battery mode. Like the Radio and Network Ack above, it may be either 

internally generated CW or from a WAV file using the same mechanism as used above for the Radio 

and Network Acks. When in CW mode, the keying speed, and tone are taken from the settings on 

the same configuration tab. 

The Delay is the amount of time between the end of a transmission and the sending of the Ack, this 

is also the time between the end of the transmission and the resetting of the timout timer and other 

internal matters.  The Minimum is the minimum amount of time that a transmission should be 

relayed through the repeater before it will send an audible ack, this is often set to a few seconds to 

ensure that the repeater will not send too many acks because of a weak signal or because of abuse. 

The Timers Tab 
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This allows for the setting of various timers that regulate the operating of the logic. Most of the 

settings are obvious. 

The Timeout sets the number of seconds that a transmission may last before the repeater times out 

and stops transmitting the audio. When that time is reached, the output audio is replaced by a 

standard telephone style busy tone until the offending transmission ends. The level of the busy tone 

is the same as that used for first callsign level. Setting the timeout to zero disables it. The Lockout 

Time is the length of time the repeater will send the busy tone before sending its callsign and closing 

down. 

The Hang Time is the time between the last acknowledgement (audible or not) and the close down 

of the repeater in the absence of any further input. The Latch Time is the minimum transmission 

length required before the repeater stays transmitting, otherwise the transmitter closes down when 

the input signal disappears and the repeater needs accessing from cold again. This feature is 

designed to stop people switching on a repeater without making an effort to identify. To disable this 

feature, set the Latch Time to zero. 

The Access Tones Tab 

 

This is where the tones for accessing the repeater via the radio are set. Traditionally a 1750 Hz 

toneburst is used to access repeaters and here that detecter can be enabled or disabled, as well as 

the detection Threshold set. The detection threshold is a measure of the sensitivity of the decoder to 

the tone to stop false triggering on weak noisy signals for example. The bandwidth of the toneburst 

detecter is 25 Hz. 

The CTCSS Frequency is set here too. All EIA CTCSS frequencies are defined, and the ones used in the 

UK also include the tone letter, there is also a None option. Like the toneburst option, there is a 
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detection Threshold to set, which will typically be lower than that for a toneburst due to the lower 

deviation used, and in addition an output Level is also settable. The CTCSS Hang Time is to allow a 

period of grace after the CTCSS tone has dropped when the station may still access the repeater, it 

can be though of as a CTCSS squelch tail. This helps with weak stations and only operated with the 

internal CTCSS detector. The output CTCSS tone can be set to be one of four modes, never, when the 

repeater is open, when audio is being relayed, and when the transmitter is keyed. 

It is possible to use an external hardware CTCSS decoder by choosing External as the CTCSS Source, 

which disables the internal CTCSS decoder and expects Input 1 to be used to signal the presence of a 

signal with CTCSS. To disable the transmitted CTCSS tone, simply set the CTCSS Level to 0%. 

All of the threshold and level sliders operate in real-time on the detection thresholds and levels 

respectively used by the repeater to aid setting up, however the values will only be stored if the OK 

button is pressed. 

The absence of tones allows the repeater to be carrier accessed, and only the Squelch 2 input is 

monitored for the radio side. Note that this feature is currently disabled. 

The external input does not use either CTCSS or 1750 Hz toneburst for access. 

The Feel Tab 

 

This is where miscellaneous settings about the repeater operation are set. Currently this includes the 

options for transmiting the Callsign when the repeater is first opened up, this may be immediately 

when the repeater is opened, or when the input transmission has exceeded the latch time. If no 

latch time has been set then this option is meaningless. Sending the Callsign when the repeater is 

about to close down is also selectable. Transmission of any of these callsigns resets the Callsign timer 
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above. Finally the type of timeout tones is settable, you can choose from the German telephone 

busy tone, the very similar British telephone busy tone, or the American telephone busy tone. 

If Callsign Holdoff is set to 1/4, 1/2, or 3/4, then the callsign is suppressed unless the callsign timer 

has already passed 1/4, 1/2 or 3/4 of its timeout value. That means that with a callsign time of ten 

minutes, and a value of 1/2, then you will never hear a callsign at less than five minute intervals. 

They may appear at startup or shutdown, as set elsewhere, but not if they occur within five minutes 

of the last one. Sending a callsign for whatever reason always resets the callsign timer. 

The Radio Tab 

 

This is where details of the hardware interfaces for connecting to a radio, and these must be filled in 

and correct before the program can run. The sound card is the one that will be connected to the 

radio, either to the standard audio input/output or directly to the discriminator/modulator or a 

mixture of the two. To use the direct discriminator/modulator connection, you will need to enable 

the de-emphasis and/or the pre-emphasis built into the program, to ensure that the transmitted 

audio is correct. You can also choose to have a simple VOGAD unit, this has a limited ability to boost 

incoming audio, the alternative to the VOGAD unit is an audio limiter. 

There is often a delay in the squelch inputs compared to the audio, this can result in annoyingly long 

squelch tails. This can be overcome by setting the audio delay which will enable the squelch input to 

match the received audio. 

This setting should be made so that no un-squelched noise appears before the transmission rather 

than completely removing the squelch tail as a small squelch tail is normal on some radios. 
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The External Tab 

 

This tab controls the optional audio input and output for connecting to external programs like 

EchoLink. This external interface may be Enabled, Disabled, or set to Control Only by the setting at 

the top of the page. If it's set to Enabled or Control Only then the sound card must not conflict with 

the sound card chosen for the radio port. It is possible that the audio will not be received by a real 

sound card, but via a Virtual Audio Cable, likewise the optional serial port control may also be 

connected via a software equivalent of a null modem cable. The Control Only option is to allow the 

external audio input to be used for DTMF commands but not for allowing user traffic. 

Like the main radio connection, it is possible to set an audio delay, as well as pre- and de-emphasis 

in case the external audio input needs to be used with a radio with direct connections to the 

discriminator and modulator. 

There is the option to choose a VOGAD in use on the External audio. With EchoLink, the audio level 

can vary enormously, with the announcements being louder than most user audio, and even the 

user audio can be variable depending on how well the user has set up EchoLink. For that reason it's 

recommended that it be enabled on the External interface when using EchoLink. The alternative to 

having the VOGAD enabled is that a simple audio limiter is used instead. 

As well as specifying the serial port itself, you can also specify which serial port pins are used for 

which purpose, this being dependent on the null modem cable used, and must match those being 

used by the external software/hardware. 

The available transmit pins are DTR and RTS, and squelch inputs are CD, CTS or DSR. 
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The Background option is to enable the sending of audio from the radio port when the repeater is 

relaying audio from the External port. This is useful for sending control signals (e.g. DTMF) to the 

External port when it is connected to a busy conference and there is no chance to send the 

disconnect DTMF sequence between overs. The external program may require some extra 

configuration to enable this option, in addition to setting this option in the repeater software. 

The functionality of this port is mirrored on the controller, see Controller below. The complete 

external interface is disabled if the External Sound Card is set to None, and any squelch input, either 

by the Velleman board or serial port will be ignored. 

The Controller Tab 

 

This sets hardware device used to control the transmitter, take input from the receiver and also the 

watchdog output is sent. Although not very useful, this may set to None for testing. A PTT Delay can 

be set here to ensure that the transmitter operates at exactly the same time that the audio is 

present. 

The Squelch Delay is used to delay the squelch signal reaching the software, and offers the 

alternative to setting a negative delay to the Audio Delay of the radio, which is a physical 

impossibility. Therefore a Squelch Delay of 80ms is equivalent to an Audio Delay of -80ms. 

The PTT and Squelch inversion settings are for interfacing to radios that have the opposite sense. 

The program uses either a Velleman K8055, a URI USB, or a serial port to connect to the transmit 

lines and squelch lines, currently no other hardware is supported. The Velleman has an interface 

number, which is set to zero by default, which is set with jumpers on the Velleman card. The name 

of the interface type also reflects the state of these jumpers, and the correct value should be 
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selected. It is possible to set "None" as the type, this is really only useful when debugging as in this 

state it's impossible to set the squelch inputs or test the transmit outputs. 

If the serial port is selected then it is possible to select one of two different pin configurations. The 

original configuration is named "Config 1" and a new set of pins are named "Config 2" and "Config 

3". A full listing of which pins are used for  which purpose is to be seen at the top of this document. 

"Config 3" was designed to be the same as "Config 2" but to only allow stations with CTCSS tones 

that are continuously running, and no possibility of carrier re-access. 

The DTMF Commands 1 and DTMF Commands 2 Tabs 
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The DTMF Commands 1 and DTMF Commands 2 tabs are used for setting up DTMF commands that 

may be received on either the radio or external ports. The port to have commands enabled is set, 

along with a threshold for the DTMF tones. The threshold slider operates in real-time on the 

threshold used by the DTMF decoder to aid setting up, however the values will only be stored if the 

OK button is pressed. 

Each command may be up to ten DTMF characters, 0-9 A-D, sending a DTMF * clears the current 

command while a DTMF # ends the command. The commands may be set up to Shutdown the 

repeater, it will immediately unkey and no callsigns or beacons will be sent, it will be listening for 

further DTMF commands though. The Startup command will put it back into listening mode, as if 

newly started. The Timeout command will immediately timeout the current user regardless of the 

timeout timer, and Timer Reset will reset the timeout timer if it is running. 

The Output 1 to Output 4 commands flip the state of four output lines, if they are available. You do 

not need to have the repeater accessed to send commands, and commands can be sent via the 

Radio or External port, as defined, when the other port is in use. All valid commands to the repeater 

are logged into the log. 

Up to two external commands may be setup to run based on DTMF Commands 2. On the screen 

there are two entries each for Command 1 and Command 2, the first entry is the DTMF characters 

used to invoke them, the second entry is the command itself. This text is sent to the shell and is 

outside the control of the repeater software, so be careful! 
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The Active Output Tab 

 

The final tab sets the hang time to be used on the active line. This will remain high for the pre-

defined period after the repeater has stopped transmitting, except in the case of a beacon 

transmission. 

Note that configuration changes do not take effect until the software is re-started. 

A log of actions and errors is to be found in the file AnalogueRepeater-YYYY-MM-DD.log where YYYY-

MM-DD is the current date. This file is normally found in the users’ home directory under Windows 

and /var/log under Linux, but this location may be overridden by the -logdir command line option. 

The log may be disabled by giving the -nolog option on the command line. Logging is still performed, 

but it goes to stderr and therefore may easily be ignored, or redirected to another target. A copy of 

the last three lines of the log is displayed at the bottom of the GUI screen. 

Once running, the screen displays status information about the software. This screen is updated 

every one second and is therefore reasonably up to date, for example the timers appear in real-time. 

This status is split into four sections, Status, Radio, External, and Timers, and each reflect a different 

facet of the repeaters operation. The updating of the GUI can be switched on and off by choosing 

the "GUI Updates" menu item under the View menu, the default is on in the Debug build and off for 

the Release build. This may be switched on in the Release build by specifying the -gui option on the 

command line. 

The State section shows the internal status as well as information about the audio passing through. 

The State entry has a number of values which include Listening, Timeout, Relaying Radio, Relaying 

External, and Waiting. The Level is the peak value of the input audio over a one second period, and 

the value is in dB relative to the peak accepted internal value, this is most useful when setting up the 
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software. Likewise the Limiter entry shows how much attenuation is being applied to the audio, and 

this value is reset when a new transmission is received. 

The Radio section shows whether the radio is transmitting, whether the radio squelch is open. The 

radio squelch indication is only set to Open when a valid input signal is being received, therefore a 

carrier on the input with no tones, the repeater is closed, and tones are enabled, will not appear. 

Likewise an input signal on the repeater when relaying audio from the external input will also not 

show. It also shows the VOGAD level, which if VOGAD is not enabled, it will show any audio limiting 

that is happening. 

It shows whether reception of a 1750 Hz toneburst and/or CTCSS tones are happening. In practice 

the 1750 Hz indication almost never appears because of the length of the tone and the GUI refresh 

speed! 

The External section is analogous to the Radio section, except for the external input, with the 

squelch input and transmit output being echoed. Like the RF Squelch, the Squelch value here is only 

valid if relaying external audio. Like the Radio section, it also includes a VOGAD level, which will 

show limiter levels if VOGAD is not enabled. 

The Timers section shows the state of the internal timers, all of their meanings have been discussed 

above, but they are fun to watch! The values are displayed as n1/n2 where n1 is the current 

counting value and n2 is the trigger value, the values of n1 may go over n2 in operation. A value of 

zero for n1 indicates that the time is not active as will be seen. 

There is a menu entry named Actions which allows local use of the remote commands for the 

software. These are Shutdown, Startup, Timeout, Time Reset, Command 1 and Command 2. 

Shutdown and Startup are self explanatory, while Timeout is used to force an early timeout for a 

user, maybe someone who is abusing the system. Time Reset is the opposite, this will reset the 

timeout timer and, if needed, remove any existing timeout condition from the current user. 

The control entries for Status 1 and Status 2 are used for triggering the status messages from the 

repeater. These messages are passed to the repeater from the ircDDB Gateway and are displayed on 

the screen, and the correct combination of Your, Rpt1, and Rpt2 will trigger a reply from the 

repeater with the status message in the slow data portion of the transmission. 

There is a menu item named Outputs which allows access to the menu items that control the output 

lines. These items are labelled "Output 1", "Output 2", "Output 3" and "Output 4". These are toggles 

and they retain their state between invocations of the software. 

In the debug version of the software, an Open option appears on the File menu. This is used for 

testing, and the presence of an input file also triggers both squelch inputs within the software too. 

Any WAV file used for this input must be mono and sampled at 48000 Hz, otherwise it will be 

rejected. 
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The DExtra and DCS Gateways 

 

 

DExtraGateway.exe [-nolog] [-gui] [-logdir directory] [-confdir directory] [config name] 

dextragateway [-nolog] [-gui] [-logdir directory] [-confdir directory] [config name] 

dextragatewayd [-daemon] [-nolog] [-logdir directory] [-confdir directory] [config name] 

 

DCSGateway.exe [-nolog] [-gui] [-logdir directory] [-confdir directory] [config name] 

dcsgateway [-nolog] [-gui] [-logdir directory] [-confdir directory] [config name] 

dcsgatewayd [-daemon] [-nolog] [-logdir directory] [-confdir directory] [config name] 

 

All versions have an optional parameter which signifies the configuration to be used, and this must 

be set on the command line when running as well as configuring the repeater. This name will appear 

on the title bar as well as affecting the name of the log file used. There could be issues in running 

more than one DExtra or DCS Gateway per repeater site if they connect to the same reflector or 

gateway. The location of the configuration file, which is used when running under Linux is normally 

found in the /etc directory. The -confdir option allows the location of the users’ home directory to 

be set explicitly, it is also a valid option under Windows but performs no function. 

The -daemon command line switch is used on the command line version to put the program into the 

background, and to disassociate it from the controlling terminal. The program will return 

immediately, but using the ps command will show that it is running in the background. 

A log of actions and errors is to be found in the file DExtraGateway-YYYY-MM-DD.log or 

DCSGateway-YYYY-MM-DD.log where YYYY-MM-DD is the current date. This file is normally found in 

the users’ home directory under Windows and /var/log under Linux, but this location may be 

overridden by the -logdir command line option. The log may be disabled by giving the -nolog option 

on the command line. Logging is still performed, but it goes to stderr and therefore may easily be 

ignored, or redirected to another target. A copy of the last three lines of the log is displayed at the 

bottom of the GUI screen. 

Normally the GUI is disabled but it may be switched on in the Release build by specifying the -gui 

option on the command line, or by clicking on the View menu and enabling the GUI Updates. 
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From the user point of view, the commands are almost identical to that found on Icom and DVAR 

systems. Briefly the user commands are, assuming that the local repeater is GB7AA__C: 

Command UR RPT1 RPT2 Comments 

To work a station on the 
local repeater 

CQCQCQ__ GB7AA__C GB7AA__C Not routed to a 
reflector, even if linked. 

To work a station on the 
currently linked reflector 

CQCQCQ__ GB7AA__C GB7AA__G  

Link to a reflector XRF999BL GB7AA__C GB7AA__G Links to reflector 
XRF999_B. 

Unlink from a reflector _______U GB7AA__C GB7AA__G  

To echo your 
transmission back to you 

_______E GB7AA__C GB7AA__G Only if enabled in the 
gateway. 

To trigger a voice 
announcement about the 
link status 

_______I GB7AA__C GB7AA__G Only if enabled in the 
gateway. 

 

Note that the underscore character is used to indicate a space character in the actual setting of the 

callsigns. 

The configuration is relatively simple. The configuration is made up of two tabs. 

The Reflector Tab 

 

This sets most of the parameters for the program. The first entry, Callsign, is the callsign that the 

software uses to connect to the reflector/gateway with, and will appear in the status pages under. 

The Reflector is the reflector that is the default reflector/repeater, it is taken from the 

DExtra_Hosts.txt file or DCS_Hosts.txt, more about this later. Next to the reflector list, is the channel 

on the reflector to link to. With DExtra the available channels are A to E, while with DCS the letters A 

to Z are available. 

Startup is a simple Yes/No choice. If set to Yes then the software will link to that reflector/repeater 

specified in the Reflector entry when it is started. Reconnect sets the operation of the software, if 

set to Fixed then the software will stay linked to the reflector specified in Reflector and all incoming 

commands to link and unlink will be ignored. If set to one of the times then incoming link and unlink 

commands will be acted upon (if valid) but after the specified period of inactivity will unlink and link 

to the reflector/repeater specified in the Reflector entry. 
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If Reconnect is set to None then all incoming commands are acted upon (if valid) and the software 

will not reconnect to the reflector/repeater specified in Reflector. 

The final option is the language of the status text to send to the repeater. This is one of English UK, 

English US, French, German, Danish, Italian, and Polish. The default is English. 

The Repeater Tab 

 

This sets the connection information to the Repeater software. Many of the comments about setting 

the Network options in the D-Star Repeater configuration also apply here. The first entry, Repeater 

Callsign, is the callsign of the repeater that is connected to the DExtra Gateway or DCS Gateway. 

The list of available reflectors and gateways is controlled by the DExtra_Hosts.txt or DCS_Hosts.txt 

file which can either found in either the home directory of the current user, or in another location. 

This location is "/usr/local/etc" on Linux and the programs running directory, probably "C:\Program 

Files\Repeater" under Windows. The file in the home directory takes precedence. The installed 

example file lists the publicly known reflectors, the format is described within the example file. 

If your system is behind a firewall or router, then it is possible that you will need to enable the 

DExtra or DCS data stream through it, and through to the Gateway. The UDP port that you need to 

pass through is 30001 for DExtra, or 30051 for DCS. 

 

The Parrot Controller 

 

 

ParrotController.exe [-nolog] [-gui] [-logdir directory] [-confdir directory] [config name] 
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parrotcontroller [-nolog] [-gui] [-logdir directory] [-confdir directory] [config name] 

parrotcontrollerd [-daemon] [-nolog] [-logdir directory] [-confdir directory] [config name] 

 

All versions have an optional parameter which signifies the configuration to be used, and this must 

be set on the command line when running as well as configuring the repeater. This name will appear 

on the title bar as well as affecting the name of the log file used. The location of the configuration 

file, which is used when running under Linux is normally found in the /etc directory. The -confdir 

option allows the location of the users’ home directory to be set explicitly, it is also a valid option 

under Windows but performs no function. 

The -daemon command line switch is used on the command line version to put the program into the 

background, and to disassociate it from the controlling terminal. The program will return 

immediately, but using the ps command will show that it is running in the background. 

A log of actions and errors is to be found in the file ParrotController-YYYY-MM-DD.log where YYYY-

MM-DD is the current date. This file is normally found in the users home directory under Windows 

and /var/log under Linux, but this location may be overridden by the -logdir command line option. 

The log may be disabled by giving the -nolog option on the command line. Logging is still performed, 

but it goes to stderr and therefore may easily be ignored, or redirected to another target. A copy of 

the last three lines of the log is displayed at the bottom of the GUI screen. 

The Parrot Controller is designed to act as an alternative to a full gateway either for testing, or for 

operating in a different mode, as a D-Star Parrot. Firstly the Parrot mode needs to be selected in the 

D-Star Repeater, and the Parrot Controller needs to be configured. 

The Parrot Controller has two modes, Parrot and Beacon. In Beacon mode, the Parrot controller will 

keep sending the same DVTOOL file to the repeater as pre-defined intervals, therefore acting as a 

repeater. The file and the interval are selectable. DVTOOL files can either be created by using my D-

Star Client software, or from DVTOOL program, or using this software as a Parrot and saving the 

file(s) generated. 

The configuration is relatively simple. The configuration is made up of four tabs. 

The Mode Tab 

 

This sets the operating mode, Parrot or Beacon. 
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The Parrot Tab 

 

This has to be set when running in Parrot mode. There are two settings, the Turnaround Time and 

whether to keep the intermediate DVTOOL files. The Turnaround Time is the delay between 

retransmitting the received data after receiving it. Two seconds is the lowest feasible value, but 

longer may be needed if the connection to the repeater program is not local. The program creates 

temporary DVTOOL files which it then retransmits, these would normally be deleted after 

transmitting, but by setting the Keep File option to Yes, then they will be kept. They are stored in the 

users’ home directory. 

The Beacon Tab 

 

This is used to set the configuration in Beacon mode. A suitable DVTOOL file should be selected, this 

is easiest done by pressing the Browse... button and selecting the file wanted. The other setting is 

the time interval between sending the beacons. 

The Network Tab 

 

This sets the connection information to the Repeater software, and is required to be valid whichever 

mode the software is operating in. Many of the comments about setting the Network options in the 

repeater configurations also apply here. 
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In Parrot mode, the software will listen for a valid D-Star transmission that is being received by the 

repeater, and save the contents in a temporary DVTOOL file, which is saved in the users home 

directory. Once the transmission has ended, this software waits two seconds and then resends the 

data back to the repeater to be retransmitted. At the end of this transmission, the file is either kept 

or deleted, depending on the setting in the configuration of the Parrot Controller. These DVTOOL 

files can be used for the beacon later. 

Normally the GUI is disabled but it may be switched on in the Release build by specifying the -gui 

option on the command line, or by clicking on the View menu and enabling the GUI Updates. 

Questions? 
The Yahoo! group pcrepeatercontroller has hundreds of subscribers who use this software, and 

asking a question their will often provide an answer for anything that is not covered in this 

document. The group also has a search function so that you can search for someone else asking the 

same question earlier. If you run any of the software described here, then it is recommended that 

you join the group, it can be found at http://groups.yahoo.com/group/pcrepeatercontroller/. 
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